FOR RESEARCH USE ONLY. NOT FOR USE IN DIAGNOSTIC PROCEDURES.

Disclaimer of Warranty and Liability

MESO SCALE DIAGNOSTICS, LLC. (“MSD”) MAKES NO REPRESENTATION OR WARRANTY OF ANY KIND, AND HEREBY EXPRESSLY EXCLUDES AND DISCLAIMS ANY AND ALL REPRESENTATIONS AND WARRANTIES WITH REGARD TO THIS INSTRUMENT MANUAL (THIS “MANUAL”), INCLUDING, BUT NOT LIMITED TO, ANY IMPLIED WARRANTY OF MERCHANTABILITY, SUITABILITY OR FITNESS FOR A PARTICULAR PURPOSE, DATA ACCURACY, SYSTEM INTEGRATION, QUIET TITLE OR NONINFRINGEMENT. NO STATEMENT IN THIS MANUAL SHALL BE INTERPRETED TO GRANT OR EXTEND ANY WARRANTY ON THE PRODUCTS DESCRIBED HEREIN. MSD SHALL NOT BE LIABLE FOR ERRORS OR OMISSIONS CONTAINED HEREIN OR FOR ANY DAMAGES OF ANY KIND, INCLUDING, BUT NOT LIMITED TO DIRECT, INDIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL OR PUNITIVE, WHETHER ARISING IN CONTRACT, TORT, STRICT LIABILITY OR OTHERWISE, THAT MAY BE INCURRED IN CONNECTION WITH THE FURNISHING, PERFORMANCE OR USE OF THIS MANUAL.

Changes in Publication

The information contained in this Manual is subject to change without notice.

Unauthorized Use of Manual Material

No part of this Manual may be duplicated, reproduced, stored in a retrieval system, translated, transcribed, or transmitted in any form or by any means without the express prior written permission of MSD. This Manual shall be returned to MSD within two (2) business days following any request by MSD.

Unauthorized Use of Trademarks or Service Marks

MESO SCALE DISCOVERY, MESO SCALE DIAGNOSTICS, MSD, MSD GOLD, DISCOVERY WORKBENCH, MULTI-ARRAY, MULTI-SPOT, QUICKPLEX, SECTOR, SECTOR PR, SECTOR HTS, SULFO-TAG, N-PLEX, R-PLEX, S-PLEX, T-PLEX, U-PLEX, V-PLEX, STREPTAVIDIN GOLD, MESO, www.mesoscale.com, SMALL SPOT (design), 96 WELL 1, 4, 7, 9, & 10-SPOT (designs), 384 WELL 1 & 4-SPOT (designs), MSD (design), N-PLEX (design), R-PLEX (design), S-PLEX (design), T-PLEX (design), U-PLEX (design), V-PLEX (design), It's All About U, and SPOT THE DIFFERENCE are trademarks and/or service marks of Meso Scale Diagnostics, LLC.

All other trademarks or service marks are the property of their respective owners.

© 2013, 2017 Meso Scale Diagnostics, LLC. All rights reserved.

Manual part number: 3-1300-0B0002-F

July 2018

Printed in USA
Table of Contents

1 Introduction ............................................................................................................................................. 7
  1.1 Intended Audience ............................................................................................................................ 7
  1.2 How to Use This Manual .................................................................................................................. 7
  1.3 Warnings and Caution Symbols ......................................................................................................... 8
  1.4 Formatting Information ..................................................................................................................... 8

2 Safety Information .................................................................................................................................. 10
  2.1 Regulatory and Safety Certifications ............................................................................................... 10
    2.1.1 Laser ....................................................................................................................................... 10
    2.1.2 WEEE Compliance ................................................................................................................... 10
    2.1.3 Hazardous Substances .............................................................................................................. 11
  2.2 Symbols and Labels ............................................................................................................................ 11
  2.3 General Operation ............................................................................................................................. 12
    2.4 Hazards ....................................................................................................................................... 13
      2.4.1 Electrical .............................................................................................................................. 13
      2.4.2 Chemical and Biological ....................................................................................................... 14
      2.4.3 Visual ................................................................................................................................... 14
      2.4.4 Mechanical ............................................................................................................................ 15
      2.4.5 ESD Sensitivity ....................................................................................................................... 15
      2.4.6 Electromagnetic Interference and Susceptibility ..................................................................... 15
  2.5 Software and Operating System Compatibility ............................................................................... 16
  2.6 Decontamination Prior to Shipping or Servicing ............................................................................. 16

3 System Description .................................................................................................................................. 18
  3.1 Intended Use .................................................................................................................................... 18
  3.2 Specifications Overview .................................................................................................................... 18
  3.3 Plate Compatibility .............................................................................................................................. 18
  3.4 System Components ............................................................................................................................ 18
    3.5 MESSO QuickPlex SQ 120 Instrument ............................................................................................ 19
      3.5.1 CCD Camera and Telecentric Lens ......................................................................................... 20
      3.5.2 Motion Control System ........................................................................................................... 20
      3.5.3 Plate Barcode Reader ............................................................................................................ 20
      3.5.4 Integrated Assay Plate Stacker ............................................................................................... 21
      3.5.5 Status LEDs .......................................................................................................................... 22
      3.5.6 Power Switch and Input/Output (I/O) Panel ............................................................................ 23
  3.6 Microsoft Windows-Compatible Computer ...................................................................................... 24
  3.7 MSD DISCOVERY WORKBENCH Software .................................................................................. 24
  3.8 Operational Modes ............................................................................................................................. 24
  3.9 Image Readout .................................................................................................................................. 24
    3.9.1 Reading Partial Plates ............................................................................................................... 26
  3.10 Electronic Test Plate .......................................................................................................................... 26
  3.11 Uninterruptible Power Supply ......................................................................................................... 26

4 Installation, Quick Start, and General Use .............................................................................................. 28
  4.1 Installation ....................................................................................................................................... 28
  4.2 Quick Start ...................................................................................................................................... 28
    4.2.1 Start-up .................................................................................................................................... 29
    4.2.2 Setup ...................................................................................................................................... 29
List of Figures

Figure 2:1 User hazards ........................................................................................................... 13
Figure 3:1 The QuickPlex SQ 120 imager and computer ................................................................. 19
Figure 3:2 Cutaway view of the imager ......................................................................................... 20
Figure 3:3 MSD and custom barcode label locations ................................................................. 21
Figure 3:4 Custom Barcode Reader Selection Dialog ................................................................. 21
Figure 3:5 Status LEDs ............................................................................................................. 22
Figure 3:6 Power switch, power entry port, and USB port on the back of the instrument .......... 23
Figure 3:7 Electrical Noise Filter ............................................................................................... 23
Figure 3:8 Notebook computer cable attachments (USB and power) .......................................... 24
Figure 3:9 SECTOR plate showing 24, 4-well sectors ............................................................... 25
Figure 3:10 Reading QUICKPLEX plates in sectors, 1 well at a time ........................................ 25
Figure 3:11 The electronic test plate ........................................................................................ 26
Figure 4:1 Status window .......................................................................................................... 28
Figure 4:2 MSD DISCOVERY WORKBENCH splash screen ...................................................... 29
Figure 4:3 MSD DISCOVERY WORKBENCH desktop icon ....................................................... 29
Figure 4:4 Setup window .......................................................................................................... 30
Figure 4:5 Loading an electronic plate ....................................................................................... 30
Figure 4:6 Run Options dialog box ............................................................................................ 31
Figure 4:7 Electronic test plate results, Color Map layer .......................................................... 32

List of Tables

Table 2:1 Hazardous Substances ............................................................................................... 11
Table 2:2 Symbols and labels ................................................................................................. 11
Table 6:1 Troubleshooting Guide ........................................................................................... 36
Table 6:2 Specifications ......................................................................................................... 38
Introduction
1 Introduction

MESO SCALE DISCOVERY (MSD) develops, manufactures, and markets biological assays that provide cost-effective and valuable information to scientists in drug discovery, therapeutic screening, and life science research. MSD’s product portfolio is based on MULTI-ARRAY® technology, a proprietary combination of patterned arrays and electrochemiluminescence detection that results in exceptional sensitivity, speed, dynamic range, and convenience.

MSD develops, manufactures, and markets detection instrument systems as well as a line of assay kits for use with these instruments, a proprietary line of reagents, and custom microplate printing and assay development services. MSD® MULTI-ARRAY microplates are available for the MESO QuickPlex® SQ 120 instrument in a 96-well format with standard or high-binding surfaces. MSD plates may be purchased uncoated or coated with proteins such as streptavidin or avidin, with anti-species antibodies such as goat anti-mouse or goat anti-rabbit, or with antibodies against specific analytes. Custom coatings and surface treatments are available.

MSD MULTI-ARRAY plates are available as single spot (single assay) plates and as MULTI-SPOT™ plates with patterned spot arrays in each well. MULTI-SPOT plates measure multiple analytes simultaneously in a single well, increasing throughput and enabling novel assay panels.

For more details and information about applications, please visit the MSD website at www.mesoscale.com.

1.1 Intended Audience

This manual is for users of the MESO QuickPlex SQ 120 instrument. Users should have an understanding of general computer and Microsoft® Windows terminology and be familiar with standard laboratory practices.

This manual describes how to operate the MESO QuickPlex SQ 120 instrument and acquire data using both SECTOR® and QUICKPLEX® plates. The analysis of this data is treated in a separate manual: DISCOVERY WORKBENCH® User’s Guide.

1.2 How to Use This Manual

This manual is organized by chapters containing main topics and subsections. Use the hyperlinked Table of Contents to find topics of interest quickly. The List of Figures and List of Tables hyperlink to the images and tables that enhance understanding of written information in the manual. The Appendix contains supplemental information on troubleshooting, instrument specifications, regulatory information, and safety symbols and labels.

Tips

Symbol ➔

Tips provide extra information or details that help users perform functions more efficiently.

Notes

Notes provide supplemental information on the proper use of the QuickPlex SQ 120 instrument and its software.
1.3  Warnings and Caution Symbols

**WARNING**

General warnings advise operators of potential hazards and highlight the procedures or information necessary to avoid personal injury during use of the QuickPlex SQ 120 instrument.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Exclamation]</td>
<td>Risk exists for a mechanical, chemical, or safety hazard</td>
</tr>
<tr>
<td>![Exclamation]</td>
<td>Risk exists for an electrical hazard</td>
</tr>
<tr>
<td>![Exclamation]</td>
<td>Risk of exposure to biohazards</td>
</tr>
</tbody>
</table>

**CAUTION**

A caution note highlights procedures or information necessary to avoid damage to equipment, corruption of software, loss of data, or invalid test results.

⚠️ **CAUTION:** Carefully read and understand all information in this document. Failure to read, understand, and follow the instructions in this publication may result in damage to the product, injury to operating personnel or poor instrument performance.

1.4  Formatting Information

This guide uses the following formatting conventions:

- Internal hyperlinks are formatted **bold/gray**. Click to jump instantly to the referenced section or figure.
- External hyperlinks are formatted **underlined/blue**. Click to create an email message or open an external web page.
- Clickstreams are indicated with arrows and always start with a top-level menu item: Select Tools ➔ Plate Data History.
- Information to be entered by the user is shown in italics: Enter Administrator.
- When referring to a term as it appears in the software, we capitalize it exactly as it is capitalized on-screen: Select Read from Bar Code from the Plate Type menu.
Safety Information
2 Safety Information

2.1 Regulatory and Safety Certifications
The QuickPlex SQ 120 has been tested to comply with applicable regulatory standards; it carries the cSGSus mark and is CE marked.

Regarding EN 61326-1: 2013 Electrical Equipment for Measurement, Control, and Laboratory Use – EMC Requirements:
- The QuickPlex SQ 120 instrument is designed for operation in a controlled electromagnetic environment. Transmitters of RF energy such as mobile (cellular) telephones should not be used in close proximity.

Regarding FCC Rules, Part 15, Subpart B, a Class A digital device:
- This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of FCC rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. The equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause interference in which case the user will be required to correct the interference at his own expense.

Regarding Industry Canada Interference-Causing Equipment Standard:
- This Class A digital apparatus complies with CAN ICES-001(A).
- Cet appareil numérique de la Classe A est conforme à la norme NMB-001(A) du Canada.

Contact MSD Scientific Support with inquiries about the regulatory compliance of MSD instrumentation.

2.1.1 Laser
The MESO QuickPlex SQ 120 is classified per CFR Title 21 part 1040.10 and part 1040.11 as a Class 1 laser product with a built-in barcode reader classified as Class 2. The QuickPlex SQ 120 is classified as Class 1 in accordance with IEC 60825-1:2014.

The MESO QuickPlex SQ 120 complies with FDA performance standards for laser products except for deviations pursuant to Laser Notice No. 50, dated June 24, 2007.

2.1.2 WEEE Compliance
The MESO QuickPlex SQ 120 was placed on the market after 2005 in compliance with European Union (EU) directive 2012/19/EU, the Waste Electrical and Electronic Equipment (WEEE) Directive.

For all inquiries regarding recycling of shipping materials and instrument disposal, contact MSD Instrument Service.
2.1.3 Hazardous Substances

In accordance with People's Republic of China Order No. 32 of the Ministry of Industry and Information Technology (Management Methods for the Restriction of the Use of Hazardous Substances in Electrical and Electronic Products), MSD has designated an environmental protection use period of 50 years for the MESSO QuickPlex SQ 120 instrument when used under normal operating conditions. Table 2:1 indicates parts containing hazardous substances.

<table>
<thead>
<tr>
<th>Part Name</th>
<th>Hazardous Substances</th>
</tr>
</thead>
<tbody>
<tr>
<td>Motor with pulley</td>
<td>X</td>
</tr>
<tr>
<td>Contact Board</td>
<td>X</td>
</tr>
<tr>
<td>Cable Assemblies</td>
<td>X</td>
</tr>
<tr>
<td>Printed Circuit Boards</td>
<td>X</td>
</tr>
</tbody>
</table>

This table was prepared in accordance with the provisions of SJ/T 11364.

O: Indicates that said hazardous substance contained in all of the homogeneous materials for this part is below the limit requirement of GB/T 26572.

X: Indicates that said hazardous substance contained in at least one of the homogeneous materials used for this part is above the limit requirement of GB/T 26572.

2.2 Symbols and Labels

Table 2:2 defines the symbols found in this manual, on the instrument, and on the instrument labels.

<table>
<thead>
<tr>
<th>Symbol/Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![WARNING]</td>
<td>Warning messages are highlighted with this symbol and the word WARNING in red. They advise operators of potential mechanical or other hazards and highlight the procedures or information necessary to avoid personal injury.</td>
</tr>
<tr>
<td>![CAUTION]</td>
<td>Caution messages are highlighted with this symbol and the word CAUTION in red. They highlight procedures or information necessary to avoid damage to equipment, corruption of software, loss of data, or invalid test results.</td>
</tr>
<tr>
<td>![Warning]</td>
<td>This warning symbol indicates a potential electrical hazard. This device contains high voltage. Disconnect the device from its power source before changing a fuse, moving the device, or connecting/disconnecting any cable.</td>
</tr>
<tr>
<td>![Biohazard]</td>
<td>These symbols indicate a risk of exposure to biohazards. Ensure surfaces are decontaminated and cleaned and proper personal protective equipment is worn to prevent exposure.</td>
</tr>
<tr>
<td>![CLASS 1 LASER PRODUCT]</td>
<td>This symbol indicates the presence of a Class 1 Laser.</td>
</tr>
<tr>
<td>![Ergonomic]</td>
<td>This warning indicates this instrument is an electrostatic sensitive device. The QuickPlex SQ 120 is sensitive to static discharge in excess of 4.0 kV.</td>
</tr>
<tr>
<td>![V]</td>
<td>This symbol indicates a measurement or requirement in Volts.</td>
</tr>
<tr>
<td>![A]</td>
<td>This symbol indicates a measurement or requirement in Amperes, often referred to as Amps.</td>
</tr>
<tr>
<td>![~]</td>
<td>This symbol indicates electric current is in the form of alternating current (AC).</td>
</tr>
<tr>
<td>![DC]</td>
<td>This symbol indicates electric current is in the form of direct current (DC).</td>
</tr>
<tr>
<td>Symbol/Label</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td><img src="image" alt="Symbol" /></td>
<td>This symbol indicates placing a toggle switch in this position will place the instrument in a powered on state.</td>
</tr>
<tr>
<td><img src="image" alt="Symbol" /></td>
<td>This symbol indicates placing a toggle switch in this position will place the instrument in a powered off state.</td>
</tr>
<tr>
<td><img src="image" alt="Symbol" /></td>
<td>The European Conformity Marking indicates that the device complies with the essential requirements of the relevant European health, safety and environmental protection legislation, which includes compliance with the Restriction of Hazardous Substances (RoHS 2) directive.</td>
</tr>
<tr>
<td><img src="image" alt="Symbol" /></td>
<td>The WEEE symbol above a horizontal bar indicates this product was placed on the market after 2005 in compliance with European Union (EU) directive 2012/19/EU, the Waste Electrical and Electronic Equipment (WEEE) Directive.</td>
</tr>
<tr>
<td><img src="image" alt="Symbol" /></td>
<td>The SGS System Certification Mark, or “Q-mark”, is issued by the Société Générale de Surveillance. It indicates this instrument has been tested by an accredited certification body for electromagnetic compatibility (EMC) and safety. This product is certified in the United States and Canada. The SGS contract number for Meso Scale Diagnostics, LLC. is 800052.</td>
</tr>
<tr>
<td><img src="image" alt="Symbol" /></td>
<td>This logo is required by the China Ministry of Industry and Information Technology. It indicates the environmental protection use period of this instrument, in accordance with Order No. 32 (Management Methods for the Restriction of the Use of Hazardous Substances in Electrical and Electronic Products). This product contains certain hazardous substances and under normal operating conditions can be used safely, without harm to the user or to the environment from these substances, for 50 years from the date of manufacture.</td>
</tr>
<tr>
<td><img src="image" alt="Symbol" /></td>
<td>This Regulatory Compliance Mark (RCM) is required by the Australian Communications and Media Authority (ACMA). It indicates this instrument complies with all applicable ACMA regulatory arrangements and the instrument meets the regulatory requirements necessary for shipment to the Australian market.</td>
</tr>
</tbody>
</table>

### 2.3 General Operation

Once initialized, the QuickPlex SQ 120 instrument enters standby mode and maintains the CCD camera at its set temperature. The instrument is ready to read plates at any time. The QuickPlex SQ 120 is designed to run indefinitely in standby mode.

**WARNING:** The instrument must be operated with all covers in place. If the unit is operated in any manner not specified in this manual, the protection provided by the equipment may be impaired.

**CAUTION:** Additional USB devices should not be connected to the QuickPlex SQ 120’s computer system or used while plates are being read.

**CAUTION:** Changes to the computer clock can cause a system error if the changes are made during a plate read. A system error may also occur if a plate is being read when the time is automatically changed from standard to daylight savings time or vice versa.

**NOTE:** The QuickPlex SQ 120 should be operated in a dust-free environment with an ambient temperature between 20 °C and 26 °C, and humidity levels between 10 % and 80 % (non-condensing). Environments or locations with high levels of vibration should be avoided. See 6.2 Specifications for complete environmental specifications.

**CAUTION:** Keep the QuickPlex SQ 120 away from direct sources of heat or cold and direct sunlight. Ensure that the rear cooling vents and the CCD camera tower cooling vents on the QuickPlex SQ 120 are not blocked.

**CAUTION:** Do not place any objects, materials, or liquid containers on top of the QuickPlex SQ 120.

**CAUTION:** Falling objects or splashing liquids, including chemically reactive or infectious reagents, can cause damage to the instrumentation or cause injuries. Avoid handling or storing infectious or radioactive materials near the QuickPlex SQ 120.
2.4 Hazards

This section contains notices and warnings of hazards and should be read carefully. Before working with the QuickPlex SQ 120, become familiar with all safety precautions and regulations concerning the handling of materials and the instrument’s electrical and mechanical components. Operating this device in a manner not specified by this manual may impair the electrical and thermal protection provided by the equipment.

As with most laboratory instruments, the QuickPlex SQ 120 presents certain hazards for users. There are six key types of hazards:

- Electrical
- Chemical and biological
- Visual
- Mechanical
- ESD sensitivity
- Electromagnetic interference and susceptibility

2.4.1 Electrical

The QuickPlex SQ 120 has been designed and tested for compliance with appropriate electrical safety standards.

⚠️ WARNING: For best performance, remove any sample or reagent spillage from the instrument. For safety, the operator should power down the instrument and disconnect the QuickPlex SQ 120’s power cord prior to cleaning near moving parts. For significant spills or liquid intrusion into the instrument enclosure (e.g., resulting from a fire protection water sprinkler), contact MSD Instrument Service.

⚠️ WARNING: The QuickPlex SQ 120 has not been tested regarding intrinsic safety. Accordingly, the QuickPlex SQ 120 must not be operated in hazardous (classified) atmospheres as defined by the National Fire Protection Association and the National Electric Code or other applicable local regulations.
WARNING: Although the QuickPlex SQ 120 uses a 24 volt DC power supply, laboratory personnel should never remove any instrument covers that would expose electrical circuits. Only authorized MSD Service personnel should perform repairs to the interior of the QuickPlex SQ 120.

NOTE: We strongly recommend that users of laboratory instruments (such as the QuickPlex SQ 120) follow the Clinical and Laboratory Standards Institute (CLSI) document entitled GP17-A3, Clinical Laboratory Safety; Approved Guideline – Third Edition, Section 8.2, Electrical Equipment.

WARNING: The instrument must be located in a position where the rear power switch and power input connector are accessible.

CAUTION: Only power supply cables with a 10A or higher current rating can be connected to the external power supply.

2.4.2 Chemical and Biological

Users are responsible for taking all necessary precautions against hazards associated with the use of laboratory chemicals. In the course of preparing assay plates to run on the QuickPlex SQ 120, users may work with potent chemicals, such as acids, bases and solvents, and thus be exposed to chemical hazards. This may also be the case when working with cleaning or disinfecting agents and with some reagents used in assays.

Laboratory regulations and good laboratory practices concerning the use of such chemicals should be followed at all times. Product labels, package inserts and product information sheets with specific usage recommendations are provided for all plates and reagents used with the instrument. Contact MSD Scientific Support to obtain safety data sheets (SDS) for MSD plates and reagents. Use personal protective equipment recommended by your facility when handling any of these reagents.

WARNING: Samples, user reagents, or controls used in assays may be infectious or biohazardous. By working with these materials, users may be exposed to biological hazards. Laboratory regulations concerning the handling of potentially infectious material should be followed at all times.

WARNING: Users should avoid breathing reagent fumes or aerosols. Gloves and goggles should be worn when disposing of used plates. If skin comes in contact with reagents, rinse the exposed area with water immediately, and follow appropriate safety protocols as determined by your facility. Dispose of used plates according to federal, state, and local regulations.

WARNING: Wear appropriate personal protective equipment and avoid skin contact and inhalation when handling plates that contain or have been exposed to hazardous reagents.

WARNING: The plate stacker input and output locations are considered susceptible to contamination during normal use. Use of personal protective equipment and good laboratory practices are strongly suggested when working in these areas.

2.4.3 Visual

The instrument uses a scanning barcode reader with a Class 2 laser rated at a maximum of 1 mW. The laser beam is not visible during normal operation. However, there is risk of exposure if the instrument is operated without the external covers and the internal barcode reader cover.

WARNING: DO NOT STARE INTO THE BEAM. The laser is only directly viewable and accessible by qualified service personnel.

CAUTION: Laser radiation. DO NOT STARE INTO BEAM. Class 2 laser product.

WARNING: Operation of the instrument without external covers and the internal barcode reader cover may result in hazardous radiation exposure.
2.4.4 Mechanical

**WARNING:** The QuickPlex SQ 120 instrument weighs 44.5 lbs. (20.2 kg.). Be careful to use proper technique when lifting it to minimize the risk of injury. Two or more people should lift from beneath the instrument. Please contact MSD Instrument Service before attempting to move the instrument.

**WARNING:** The QuickPlex SQ 120 instrument presents potential mechanical hazards. To avoid injury, do not touch any part of the instrument while it is in operation. Do not place fingers in the plate stacker or the plate carrier when the instrument is in operation.

**WARNING:** Moving parts of the QuickPlex SQ 120 instrument can be damaged or become misaligned when exposed to strong mechanical force. As with any mechanical instrument, you should take certain precautions when operating the QuickPlex SQ 120, including:

- Do not wear loose garments or jewelry that could catch in moving mechanisms.
- Operate the instrument with the cover intact.
- Keep hands away from pathways of moving parts during operation.
- Do not attempt electrical or mechanical repairs.
- Do not bump into or lean on the QuickPlex SQ 120 or place any objects on top of it.

2.4.5 ESD Sensitivity

The instrument contains sensitive electronics and can be damaged if it is exposed to electrostatic discharges in excess of 4.0 kV. While the instrument complies with electrostatic discharge (ESD) standards for this type of laboratory equipment, MSD recommends standard precautions to minimize ESD. In typical laboratory environments, electrostatic discharge should not be a problem.

2.4.6 Electromagnetic Interference and Susceptibility

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of FCC rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. The equipment generates, uses, and can radiate radio frequency energy, and, if not installed and used in accordance with the instruction manual, may cause interference, in which case users will be required to correct the interference at their own expense.

Changes or modifications not expressly approved by MSD may void the warranty. The operator shall use any special accessories provided with the equipment such as the power supply or shielded cables that are necessary for compliance with FCC standards.

**CAUTION:** The QuickPlex SQ 120 instrument has been tested for operation in a controlled electromagnetic environment. Transmitters of RF energy such as mobile (cellular) telephones should not be used in close proximity.

**CAUTION:** To avoid interference from electrical transients, plug the notebook computer and the instrument into outlets on the same circuit. If an uninterruptible power supply (UPS) is available, plug the notebook computer and instrument into the battery backup outlets. Please contact MSD Scientific Support if you have questions or need assistance.
2.5 Software and Operating System Compatibility

The Microsoft Windows® Update service can affect the operation of the instrument software. When running, the update application can turn off the database services upon which the instrument relies, causing errors and stopping instrument operation. Updates should not be run during instrument use. Run manually or schedule Windows and other software updates when you are sure that the instrument will not be in use.

Occasionally, Windows Update does not restart the database server after it runs. This will cause the instrument software to run incorrectly. Restarting the computer will restart the database service and restore the instrument to full operation.

The QuickPlex SQ 120 system has not been tested for compatibility with all programs. Installation of additional applications, such as anti-virus and security programs, may interfere with function.

⚠️ CAUTION: Turn off automatic Windows and application update installation to prevent the system from automatically restarting while a run is in progress.

⚠️ CAUTION: Installation of additional software on the computer system used to operate the QuickPlex SQ 120 is not supported. Specifically, updating aspects of the operating system or installing any software that changes parameters of the computer environment could interfere with proper operation of the instrument software.

⚠️ CAUTION: Running screen-savers, automated maintenance software, network-security software, and other software on the QuickPlex SQ 120 computer system could cause conflicts with the operation of the instrument software.

⚠️ CAUTION: The instrument generates files when running. Virus scanning on the instrument computer can interfere with instrument operation. It is suggested that any virus checking software run on the instrument computer be configured to minimize the scanning of newly generated files while the instrument is operating.

⚠️ CAUTION: Use of other applications while plates are being read may interfere with system performance. Use of operating system power features that disable USB communication, such as Hibernate or Sleep, will cause the system to stop responding.

2.6 Decontamination Prior to Shipping or Servicing

The QuickPlex SQ 120 instrument may have been used to analyze infectious materials or used in an environment where infectious materials were handled. For the protection of future users and service personnel, please follow site safety procedures and the directions of the site safety officer to disinfect the QuickPlex SQ 120 instrument. If shipping to MSD, contact MSD Instrument Service to determine the level of decontamination required.

⚠️ WARNING: Follow site safety procedures and the directions of the site safety officer to determine decontamination requirements for the imager before shipping or service.

⚠️ WARNING: Prior authorization must be obtained before the instrument and/or its accessories are shipped to MSD. Authorization is contingent upon completion of the MSD Instrument Decontamination Certification Form and issuance of a Returned Merchandise Authorization (RMA) number by MSD Instrument Service.
System Description
3 System Description

3.1 Intended Use
The MESCO QuickPlex SQ 120 is for research use only. The instrument is not for use in diagnostic procedures.

3.2 Specifications Overview
The QuickPlex SQ 120 instrument offers high sensitivity and a dynamic range that exceeds 5 logs. The QuickPlex SQ 120 instrument is designed to read both SECTOR and QUICKPLEX plates. The QuickPlex SQ 120 instrument reads SECTOR plates 4 wells at a time (24 sectors per plate). QUICKPLEX plates are read 1 well at a time.

The QuickPlex SQ 120 instrument reads a SECTOR plate in approximately 1 minute, 30 seconds and a QUICKPLEX plate in 2 minutes, 45 seconds. The level of multiplexing does not affect plate read time.

The QuickPlex SQ 120 instrument will distinguish SECTOR and QUICKPLEX plate types by reading the plate’s barcode and will automatically read each plate accordingly.

3.3 Plate Compatibility
The QuickPlex SQ 120 is compatible with all 96-well SECTOR and QUICKPLEX plates.

3.4 System Components
A standard QuickPlex SQ 120 system consists of the following:

- MESCO QuickPlex SQ 120 instrument (Figure 3:1)
- Microsoft Windows-compatible notebook computer (Figure 3:1)
- Notebook computer power supply and AC cord
- MSD DISCOVERY WORKBENCH software (installed)
- MSD DISCOVERY WORKBENCH User’s Guide (installed)
- Instrument Manual (installed and printed)
- Electronic test plate
- USB communication cable
- Instrument 24 volt DC power supply and power cords
- Electrical noise filter and power cord
- Uninterruptible power supply (UPS)
3.5 Meso QuickPlex SQ 120 Instrument

The main components of the QuickPlex SQ 120 instrument (Figure 3.2) include:

- CCD camera and telecentric lens
- Plate motion control system (not shown)
- Plate barcode reader (long side)
- Integrated assay plate input/output stacks
- Instrument status LEDs
- Power switch and I/O panel (not shown)
3.5.1 **CCD Camera and Telecentric Lens**

The instrument uses a very sensitive, high-resolution CCD camera and lens system to detect light emitted from MULTI-ARRAY and MULTI-SPOT plates. The custom-designed lens provides high efficiency and uniform collection of ECL generated light. For optimal sensitivity, the camera sensor is cooled to a temperature of -25 °C and maintained at this temperature within a control band of ±2 °C.

3.5.2 **Motion Control System**

The instrument uses a high-precision mechanism for transporting plates from the input stack, into the CCD camera’s viewing area, and back to either the input or output stack, depending on user setup in the DISCOVERY WORKBENCH software. See Section 4 Installation, Quick Start, and General Use for more information on reading a plate.

3.5.3 **Plate Barcode Reader**

The instrument uses a single, internal barcode reader to identify the plate at the beginning of a plate read. The barcode information allows DISCOVERY WORKBENCH software to identify the plate type and to read and interpret the plate data correctly.

For certain applications, users may be interested in applying custom barcode labels. Custom barcodes may be placed on the side of the plate next to the MSD barcode. Figure 3:3 illustrates where custom barcode labels may be placed. Custom barcodes must be either Code 39 or Code 128, with a minimum line width of 7 mils.
To enable custom barcode reading, open the instrument reader window, navigate to Tools → Instrument Configuration, and select Enable Long-side Custom Barcode Reader.

If you have questions concerning the use of custom barcodes on MSD plates, please contact MSD Scientific Support.

### 3.5.4 Integrated Assay Plate Stacker

The QuickPlex SQ 120 instrument includes an integrated assay plate stacker for loading and unloading plates. The stacker can process up to 5 plates at a time.

**CAUTION:** The maximum capacity of the input and output stacks is 5 plates. Do not load more than 5 plates into the input stack (right side) at a time and do not allow more than 5 plates to accumulate in the output stack (left side).

**WARNING:** The stacker contains components that can move at any time. Even though the door automatically retracts if an obstruction is detected, users should never place their fingers into the input or output stacks for any reason unless the instrument is completely powered off.
3.5.5 Status LEDs

The status LEDs built into the camera tower are used to indicate the operational mode of the imager (Figure 3:5).

- **Steady blue**: Imager is in standby mode and is ready to read plates.
- **Blinking blue**: Imager is currently reading a plate.
- **Steady red**: Imager is in error mode or is waiting for plates.

![Figure 3:5 Status LEDs](image-url)
3.5.6 Power Switch and Input/Output (I/O) Panel

The on/off switch, power entry port, and a USB port for communication between the instrument and notebook computer are located on the back of the instrument. Typically, the instrument should be left powered-on to maintain camera temperature.

**WARNING:** Only use cables and accessories supplied with the instrument. Use of cables and accessories other than those supplied may degrade instrument performance and cause an electrical hazard.

The power supply cannot be plugged directly into the imager. The system is supplied with an electrical noise filter, which protects the system from electrical noise. Connect the 10-pin connector from the power supply into the electrical noise filter’s power entry port (Figure 3:7). Use the 6-pin power cord to connect the electrical noise filter to the power entry port on the back of the imager (Figure 3:6).

![Power Entry Port (Pinout)](image)

<table>
<thead>
<tr>
<th>Socket</th>
<th>Voltage</th>
</tr>
</thead>
<tbody>
<tr>
<td>1, 2, 3, 4, 5</td>
<td>-V</td>
</tr>
<tr>
<td>6, 7, 8, 9</td>
<td>+V(24 VDC)</td>
</tr>
<tr>
<td>10</td>
<td>No Connection</td>
</tr>
</tbody>
</table>

**Figure 3:6 Power switch, power entry port, and USB port on the back of the instrument**

**Figure 3:7 Electrical Noise Filter**
3.6 Microsoft Windows-Compatible Computer

A notebook computer is configured by MSD for use with the instrument and comes preloaded with MSD DISCOVERY WORKBENCH Software. The notebook computer and its software are an integral part of the system and should only be modified by an MSD service engineer. The computer is connected to the instrument by a single USB cable (Figure 3:8).

![Figure 3:8 Notebook computer cable attachments (USB and power)](image)

3.7 MSD DISCOVERY WORKBENCH Software

DISCOVERY WORKBENCH is a Windows application that supports the operation of the instrument, stores both current and historical plate data, and analyzes and presents results. The application has several components: instrument modules, a secure database (the Plate Data History), kit layouts, data integrity features, and data analysis functions. Please refer to the DISCOVERY WORKBENCH User’s Guide for additional information.

3.8 Operational Modes

The instrument can be configured as a stand-alone reader or integrated with robotic systems. It has 3 operational modes:

- **The 1-stack mode** uses only the input plate stack for both loading and unloading single plates.
- **The 2-stack mode** uses the input and output plate stacks for loading and unloading multiple plates. Up to 5 plates may be loaded into the input stack at a time. Output stack capacity is also 5 plates.
- **The robotic operational mode** can use either the 1-stack or 2-stack mode with robotic handling of plates. See 4.4 Robotics Integration for general information on robotic application.

3.9 Image Readout

The QuickPlex SQ 120 uses a CCD camera to obtain images of the plate during readout. One advantage of imaging detection is that the time required to read a plate is independent of the format of the plate (i.e., both single spot and MULTI-SPOT plates are read in the same amount of time).

The QuickPlex SQ 120 reads both SECTOR (Figure 3:9) and QUICKPLEX plates. When reading QUICKPLEX plates, the QuickPlex SQ 120 instrument reads each well within a sector individually. The wells in each group are read in the following order: upper left, upper right, lower left, lower right. (Figure 3:10).

The QuickPlex SQ 120 instrument reads SECTOR plates at a rate of 1 minute, 30 seconds per plate and reads QUICKPLEX plates 1 well at a time at a rate of 2 minutes, 45 seconds per plate.
Figure 3:9 SECTOR plate showing 24, 4-well sectors

Figure 3:10 Reading QUICKPLEX plates in sectors, 1 well at a time
3.9.1 Reading Partial Plates

The QuickPlex SQ 120 can also be set up to read partial plates. When reading partial plates, the QuickPlex SQ 120 reads both SECTOR and QUICKPLEX plates in sectors (Figure 3:9). You may specify the sectors (not the individual wells) that will be read. Refer to the DISCOVERY WORKBENCH User’s Guide for more information on reading partial plates.

3.10 Electronic Test Plate

Each QuickPlex SQ 120 system is shipped with an electronic test plate (Figure 3:11). This test plate verifies operation of the system and can be used for operational qualification. It does not verify performance and should not be used for calibration purposes or performance qualification.

The electronic plate consists of an electronic circuit board housed in a plastic carrier in the shape of a standard assay plate. The circuit board for the electronic test plate has 24 separate sectors, simulating the structure of a QUICKPLEX plate (Figure 3:10).

Figure 3:11 The electronic test plate

On the electronic test plate, wells 9, 22, 35, 48, 52, 63, 74, and 85 contain an LED that tests the CCD camera. The remaining sectors include known electronic components for testing the electrical functionality of the instrument across its range of operation. The electronic plate can be used without any chemical reagents to check instrument function at the start of each day or as a tool for demonstrating the instrument and software to new users.

Store the electronic plate in its case when not in use, and keep the electronic plate clean and free of dust and debris.

To use, place the electronic plate in the input stack with the chamfered corners of the plate facing into the instrument (Figure 4:5). This orientation ensures that the barcode reader can read the barcode label. See Section 4 Installation, Quick Start, and General Use for more details.

3.11 Uninterruptible Power Supply

The QuickPlex SQ 120 should be operated with an uninterruptible power supply (UPS) to ensure the integrity of data in the event of power line transients.

The UPS required will depend on the standard operating voltage at your laboratory's location. Please ensure that the proper UPS is employed for the power conditions in your country and local area.

⚠️ CAUTION: To avoid interference from electrical transients, plug the notebook computer and the instrument into outlets on the same circuit. If an uninterruptible power supply (UPS) is available, plug the notebook computer and instrument into the battery backup outlets. Please contact MSD Scientific Support if you have questions or need assistance.
Installation, Quick Start, and General Use
4 Installation, Quick Start, and General Use

4.1 Installation
A qualified MSD service engineer must install and configure the QuickPlex SQ 120 system before use. Installation includes setup, connection of the instrument to its computer, and verification that the system is functioning properly. Only the computer provided with the instrument and preconfigured by MSD should be used to operate the instrument.

⚠️ **WARNING:** The instrument must be located in a position where the rear power switch and power input connector are accessible.

4.2 Quick Start
This chapter explains how to run the electronic test plate on the QuickPlex SQ 120 instrument and verify that the instrument acquires data and functions properly. The electronic test plate may be run at the start of each day as a part of standard operation.

![Figure 4.1 Status window](image-url)
4.2.1 Start-up

The QuickPlex SQ 120 instrument has a cooled CCD camera that needs to be brought to operating temperature before plates are read. This cooling process can take up to 25 minutes. To initiate the cooling process, turn on the instrument and start the DISCOVERY WORKBENCH software to allow the camera to cool to -25 °C automatically.

You can monitor the cooling progress by viewing the DISCOVERY WORKBENCH software Status window, which displays the temperature of the CCD camera (Figure 4:1). The Status window is accessible by selecting Tools from the menu bar in the DISCOVERY WORKBENCH software. Once the temperature indicator disappears, the instrument is ready for use.

**NOTE:** We suggest that the instrument be left on so that the CCD camera stays at operating temperature and the instrument is ready to run assay plates at any time.

To start the system:

1. Turn on the QuickPlex SQ 120 instrument and the notebook computer connected to it.
2. Log on to the Windows operating system. To do this, enter *Administrator* as the user login name and *MsdAdmin* as the password. (This is the default login shipped with the system; you may change this login/password or add additional Windows user accounts.)
3. The QuickPlex SQ 120 software within DISCOVERY WORKBENCH will automatically start and the QuickPlex SQ 120 splash screen (Figure 4:2) will display while the instrument is initializing.

**Figure 4:2 MSD DISCOVERY WORKBENCH splash screen**

4. If DISCOVERY WORKBENCH does not start automatically, double-click the MSD DISCOVERY WORKBENCH icon on the Windows desktop (Figure 4:3).

**Figure 4:3 MSD DISCOVERY WORKBENCH desktop icon**

4.2.2 Setup

On the left side of the Instrument window in DISCOVERY WORKBENCH, users can view and edit the Setup selections for reading the electronic test plate (Figure 4:4).

1. Select Read from Bar Code on the Plate Type Menu (Figure 4:4).
2. Leave the Apply Kit Layout box unchecked. This option is covered in the DISCOVERY WORKBENCH User Guide.
3. Check Read and enter 1 in the text field.
4. Load the electronic test plate into the input stack with the chamfered corners of the plate facing into the instrument (Figure 4:5). Note that if an assay plate is installed backwards, sensors in the instrument will automatically identify the plate orientation and adjust the data acquisition and analysis accordingly.

**Figure 4:5 Loading an electronic plate**

**NOTE:** If the instrument is unable to read the barcode on the electronic plate (or if no barcode label is present), the plate will be skipped and ejected from the instrument. Please contact MSD Scientific Support for assistance.

### 4.2.3 Run

When the CCD camera reaches proper operating temperature, the Instrument Log (click Show Log in the Status window) will indicate that the temperature is locked. At that point, the instrument is ready.

Click the Run button in the Instrument window. The Run Options dialog window will open (Figure 4:6).

1. **Verify Setup Selections.** If changes are necessary, click Cancel, make changes to Setup (4.2.2 Setup) and re-verify Setup Selections.

2. **Run Name** is optional, but can be entered in the second section. The Run Name is useful when a number of plates will all be read together that are part of a single experiment, enabling quick lookup of data from groups of related assay plates.

3. **Verify the Export information** and make changes if necessary (Refer to the DISCOVERY WORKBENCH User’s Guide for additional details.) The export selections control the format and the location of the exported text data file that will be created when the electronic plate is read.
4. Click **OK**. The plate read starts. View the status in the lower left region (Status bar) of the DISCOVERY WORKBENCH software to monitor progress. When the plate read is complete, the electronic plate is ejected to the output stack and Run is enabled again.

4.2.3.1 **Operations**
The Pause, Stop, Eject, and Retract buttons operate the motion control system that moves plates through the instrument.

- **Pause**: Pauses the plate read. Selecting Pause again resumes the read.
- **Stop**: Stops the current run and ejects the plate if it has already been retracted into the instrument.
- **Eject**: Transfers a plate from inside the instrument (if not being read) to the stacker output port where it may be retrieved. This function is disabled during a plate run.
- **Retract**: Lowers the stacker mechanism if needed and then ensures the instrument door is closed. Any plates in the input location will remain where they are. No further action is taken without input from the operator. This function is disabled during a plate run.

![Figure 4.6 Run Options dialog box](image)

**Figure 4.6 Run Options dialog box**
4.2.4 Results

The software provides several options for viewing results. Select View → Layer Views from the menu or select a layer from the Layer menu on the toolbar. Refer to the DISCOVERY WORKBENCH User's Guide for details on data viewing options. If you observe the data as it is acquired in Color Map view, bright wells should display numbers above 2000 and dark wells should display numbers below 200.

Figure 4.7 shows a Color Map view of the data from the demonstration plate. The values shown in this figure will differ slightly each time the plate is read. This behavior is expected.

Figure 4.7: Electronic test plate results, Color Map layer

When using the electronic test plate, wells A9, B10, C11, D12, E4, F3, G2, and H1 should display numbers above 2000, as shown in Figure 4.7. All other wells should display background signal.

4.3 Run Multiple Plates

For multi-plate runs, do not select Return Plates to Input Stack. Up to 5 plates may be loaded into the input stacker per run. Loading more than 5 plates is not recommended. Plates will accumulate in the output stack of the instrument and can be removed at any time. Do not allow more than 5 plates to accumulate in the output stack.

4.4 Robotics Integration

The instrument can be integrated with a robotics system for loading and unloading plates using the Remote Instrument Mode, which allows the instrument to be used as a component through its remote interface. A remote instrument manual that provides descriptions of the commands recognized by the MSD software is available upon request. Contact Scientific Support for more information on robotics integration.
Maintenance
5 Maintenance

This chapter provides information on maintenance for the QuickPlex SQ 120 system. The QuickPlex SQ 120 has been designed to require minimal maintenance. A qualified MSD service engineer should perform all maintenance procedures that are not categorized as user maintenance items.

5.1 User Maintenance
User maintenance of the QuickPlex SQ 120 system is minimal and mainly consists of keeping the outside of the instrument clean along with basic maintenance of the QuickPlex SQ 120 computer.

⚠️ WARNING: Opening the instrument to perform maintenance incurs risk of mechanical, electrical, and laser hazards.

Inspect the instrument before and after each use to ensure that there is no debris (liquid, dirt, plastic items, etc.) on or near the input and output stacks. Clean the instrument when needed as described below.

5.1.1 Computer Maintenance
Please perform periodic system maintenance on the computer when the instrument is not in use in order to maintain high performance. This includes running the defragmentation program included with the operating system on a regular basis, discarding unneeded files, and ensuring that there is adequate disk space on the computer.

5.1.2 Performance Qualification
A Performance Qualification Kit—containing plates, reagents, and a protocol for verifying instrument performance—is available for purchase (MSD catalog # R31QQ-3). MSD Scientific Support can provide more details on the performance qualification kit.

5.1.3 Cleaning and Exterior Decontamination
Any of the outside surfaces of the QuickPlex SQ 120 instrument, accessible regions of the input and output stacks, and stacker elevator can be cleaned in the event of a fluid spill onto the instrument or for general cleanliness. Power to the instrument must be disconnected before cleaning.

⚠️ WARNING: The instrument should be turned off and unplugged for all cleaning processes.

Acceptable cleaning solutions include water, 70 % ethanol, 1 % bleach in water, or a mild detergent. Choose a cleaning solvent that is appropriate for the nature of the spill. Lint-free cleaning wipes are recommended. Please follow all safety protocols for your facility.

If chemical reagents are spilled inside the light-tight enclosure, contact MSD Instrument Service for instructions.

5.2 Preventive Maintenance
MSD recommends at least one preventive maintenance visit per year for the QuickPlex SQ 120. Only MSD service engineers should perform standard preventive maintenance, which includes cleaning and lubricating all appropriate internal components. Service contracts are available through MSD.
Appendix
6 Appendix

6.1 Troubleshooting Guide

Refer to Table 6.1 below to troubleshoot hardware and operating errors. The software version may be found in Help → About Workbench.

<table>
<thead>
<tr>
<th>Symptom/Error message on screen</th>
<th>Possible Cause</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instrument or computer does not power on.</td>
<td>Loose or disconnected power cord(s)</td>
<td>Ensure that the power cords connecting the instrument and/or computer to the external power source are plugged in properly.</td>
</tr>
<tr>
<td></td>
<td>No voltage at outlet</td>
<td>Test the outlet by connecting a different electrical device to the outlet.</td>
</tr>
<tr>
<td></td>
<td>One or more fuses activated</td>
<td>Fuses on the QuickPlex SQ 120 instrument are internal and must be replaced by an MSD Service Engineer.</td>
</tr>
<tr>
<td>The plate passes through the instrument without being read. The Status window jumps from 1 % to 100 %.</td>
<td>The instrument was unable to read the barcode on the plate. The barcode may be damaged, smudged, marked, or otherwise unreadable.</td>
<td>Verify a barcode is smoothly affixed to the side of the plate. Then, select the appropriate plate type from the pull-down menu, and read the plate again. If the barcode is damaged, reverse the orientation of the plate so that the barcodes on the other side of the plate are read.</td>
</tr>
<tr>
<td>Error 515 General error The instrument failed to read the plate after clicking the Run button.</td>
<td>Windows security settings, networking parameters, or the instrument name has changed.</td>
<td>Click OK to continue. Determine whether your IT department has made any changes to the instrument computer recently.</td>
</tr>
<tr>
<td></td>
<td>Incompatible anti-virus software has been installed on the instrument computer.</td>
<td>Disable the antivirus program temporarily to see if that is the issue. There are several methods: 1) Exclude the file: C:\Program Files (x86)\MSD Discovery Workbench\lib\prefs.properties from scanning. 2) Disable real-time scanning. 3) Uninstall the antivirus program and use a different program.</td>
</tr>
<tr>
<td>Error 515 General error The instrument failed to initialize after clicking the instrument icon.</td>
<td>The Windows theme has changed.</td>
<td>Click OK to continue. Restore the default Windows theme. Please check whether your IT department has made any changes to the instrument computer recently. The sysinfo file contains a software log that can be used to diagnose the problem. See Section 7.2 below for instructions on creating a sysinfo file.</td>
</tr>
<tr>
<td>Error 515 General error The error was noted while reading a plate or during data analysis.</td>
<td>The Plate Data History (database) is full.</td>
<td>Click OK to continue. Backup and clear the database. For DISCOVERY WORKBENCH v4, instructions on backing up and clearing the database may be found in the DISCOVERY WORKBENCH User’s Guide. The software log will contain a message such as: Could not allocate space for object ‘PIDTable’ ....in database ‘LCPRSchema’ because the ‘PRIMARY’ filegroup is full.</td>
</tr>
<tr>
<td>Error 6106 Instrument initialization failed</td>
<td>The instrument or computer has experienced a communications failure.</td>
<td>Perform the following steps: 1) Shut down the computer. 2) Shut down the QuickPlex SQ 120 instrument. 3) Restart the computer. 4) Restart the QuickPlex SQ 120 instrument.</td>
</tr>
<tr>
<td>Symptom/Error message on screen</td>
<td>Possible Cause</td>
<td>Corrective Action</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>---------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Error 7461 Instrument not ready when starting a plate run.</td>
<td>The camera has not reached the proper temperature for operation. The QuickPlex SQ 120 camera will cool to -25 °C before the instrument becomes operational.</td>
<td>Check the camera cooling status (Tools → Status). The temperature should be dropping toward the operating temperature. Wait up to 30 minutes for the camera to stabilize at the correct temperature. This is a normal function of turning on the instrument. Restart the software. Check the temperature again. Contact MSD Scientific Support if the camera temperature is not dropping.</td>
</tr>
<tr>
<td>Error 8704 The SQL Server (MESOSCALE2) service has not started</td>
<td>The Windows service has not started.</td>
<td>It may take up to 5 minutes for this service to start after the computer is started. If the error is caused because DISCOVERY WORKBENCH was launched before the service started, then restarting the software will resolve it. If the service has been interrupted, it must be restarted. This can be accomplished by restarting Windows, or the service can be manually restarted as follows: 1) Right-click My Computer on the desktop and select Manage. In the Computer Management window under Services and Applications, click Services. 2) In the alphabetical list of services, right-click SQL Server (MESOSCALE2) and select Restart.</td>
</tr>
<tr>
<td>Error 8906 Invalid Plate Type</td>
<td>A discontinued plate or a plate configuration exclusive to another instrument was used.</td>
<td>Discontinued plates cannot be run. Plates made for SECTOR PR instruments are incompatible with the QuickPlex SQ 120 instrument.</td>
</tr>
<tr>
<td>Error 9460 Instrument timed out</td>
<td>Communication between the instrument and the computer has been interrupted.</td>
<td>Check the cables attached to the instrument and computer to make sure they are correct and securely seated. If all cables are properly connected, contact Scientific Support. The sysinfo file contains a software log that can be used to diagnose the problem. See Section 7.2 below for instructions on creating a sysinfo file.</td>
</tr>
<tr>
<td>Error 9711 Unable to connect to the instrument server</td>
<td>Communication between the instrument and computer has been interrupted.</td>
<td>Restart the computer and then check that the SQL Server Service has started. To do so, navigate to the Control Panel and open Administrative Tools → Services. Scroll down to the service named SQL Server (MESOSCALE2) and check that the status is started. If the service is not started, right-click the service and select All Tasks → Start. If the option to start the service is disabled, log in to Windows as an administrator, and try to start the service.</td>
</tr>
<tr>
<td>Error 9901, 9902 Communications failure</td>
<td>The instrument lost communication with the computer.</td>
<td>Ensure that both the instrument and computer are powered on and all power and communications cables connected and secure. Close DISCOVERY WORKBENCH and restart the computer. If restarting does not correct the problem, then switch the location of the instrument-to-computer USB cable by plugging the USB cable into a different USB port on the instrument computer. 1) Turn off the QuickPlex SQ 120 instrument. 2) Wait 30 seconds. 3) Turn on the QuickPlex SQ 120 instrument. 4) Restart the computer. 5) Wait 5 minutes before starting the MSD DISCOVERY WORKBENCH software. If the problem is not resolved, contact Scientific Support.</td>
</tr>
</tbody>
</table>
6.2 Specifications

6.2.1 Meso QuickPlex SQ 120 Instrument Specifications

All performance information given below, including standard signal levels, detection limits, dynamic range, and instrument noise, is based on 150 µL read volumes in 96-well MULTI-ARRAY plates using standard plate read parameters.

<table>
<thead>
<tr>
<th>Scientific Performance</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Standard Signal Levels</strong></td>
</tr>
<tr>
<td>Signals generated by Free TAG, 15,000</td>
</tr>
<tr>
<td>Signals generated by PQ Low Control</td>
</tr>
<tr>
<td><strong>Dynamic Range</strong></td>
</tr>
<tr>
<td><strong>Electronic Noise</strong></td>
</tr>
<tr>
<td>Standard Deviation of Dark Noise (one spot plates)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Plate Read Times</th>
</tr>
</thead>
<tbody>
<tr>
<td>96-well SECTOR Plate (singleplex and multiplex)</td>
</tr>
<tr>
<td>96-well QUICKPLEX plate (singleplex and multiplex)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Environmental Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Operational Temperature Range</strong></td>
</tr>
<tr>
<td><strong>Operational Humidity Range</strong></td>
</tr>
<tr>
<td><strong>Storage Conditions</strong></td>
</tr>
<tr>
<td><strong>Ambient Light</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Input Power Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Voltage</strong></td>
</tr>
<tr>
<td><strong>Current</strong></td>
</tr>
<tr>
<td><strong>Power Consumption</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Instrument Power Requirements*</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Voltage</strong></td>
</tr>
<tr>
<td><strong>Current</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Physical Dimensions</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Size</strong></td>
</tr>
<tr>
<td><strong>Weight</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Plate Standard Read Volume</th>
</tr>
</thead>
<tbody>
<tr>
<td>96-well MULTI-ARRAY/MULTI-SPOT Plates</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Custom Barcode Compatibility</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code 39, Code 128</td>
</tr>
</tbody>
</table>

*an approved low voltage power adapter must be used with the product to modify the input power to the instrument power.
6.2.2 MSD Plate Specifications

MSD plates are designed to comply with the mechanical dimensions of the proposed standards of the Society of Biomolecular Screening. Contact MSD Scientific Support for further details.

MSD plate barcode labels conform to ISO/IEC 16388, Information technology – Automatic identification and data capture techniques – Code 39 bar code symbology specification.
Technical Support
7 Technical Support

MSD provides excellent and timely support for all authorized users of the QuickPlex SQ 120. We welcome and carefully consider all bug reports and suggestions for improvements to future versions. We will work with you to resolve any problems you may encounter.

7.1 Bug Reports and Suggestions
Please send comments or feedback on the software, including bug reports, unresolved error codes, feature requests, or design change requests, to MSD Scientific Support at scientificsupport@mesoscale.com.

7.2 Problems Running the QuickPlex SQ 120
If you encounter an error report that you cannot resolve, please provide us with as much of the following information as possible:

- The error code and text in the error dialog box
- What you were doing when the error occurred
- A description of how the error is reproduced
- If requested by MSD Scientific Support, a copy of the SysInfoOutput.txt file located in C:\sysinfo

To generate the report file, first run the SysInfo.exe diagnostic tool as an administrator. A copy of the tool is located in (Win7-64 bit) C:\Program Files (x86)\MSD DISCOVERY WORKBENCH\bin. The instructions for running this tool are as follows:

1. Hold down the Shift key and right-click on the SysInfo.exe file.
2. Select “Run as administrator” and enter administrator credentials if requested.
3. Wait about 5 minutes to allow the tool to complete creating the file.
4. Browse to the C:\sysinfo folder
5. Right click on the “SysInfoOutput.txt” file and choose “Send To > Compressed (zipped) folder”
6. Email the SysInfoOutput.zip file to MSD Scientific Support at scientificsupport@mesoscale.com.

Email this information to scientificsupport@mesoscale.com. Someone will contact you within two business days. If the error is affecting your work, please mark it URGENT and we will respond as quickly as possible.

7.3 How to Contact Us
Meso Scale Diagnostics, LLC. company headquarters is located at:

1601 Research Boulevard
Rockville, Maryland 20850 USA
+1 240-314-2600

Our website is www.mesoscale.com.

Customer Service  Scientific Support  Instrument Service
+1 240-314-2795 +1 240-314-2798 +1 301-947-2057
customerservice@mesoscale.com scientificsupport@mesoscale.com instrumentservice@mesoscale.com